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A gyakorlat célja: hozzásegíteni a hallgatókat ahhoz, hogy megismerkedhessenek napjaink talán legizgalmasabb 
felületvizsgáló eszközcsoportjának (SPM, Scanning Probe Microscope) egyikével, az STM-mel (Scanning Tunneling 
Microscope, pásztázó alagútmikroszkóp), mérések végzésével és a nyert képek számítógépes kiértékelésével.  

Érdemjegy: A gyakorlati jegyet a felmutatott tájékozottság, ügyesség és az utólag elkészítendõ jegyzõkönyv 
színvonala együttesen határozzák meg. Elõnynek számít, ha valaki a máshol tanultakat megfelelõen össze tudja 
kapcsolni az STM gyakorlat kísérleti és elméleti tudnivalóival. Elõnyös az is, ha valaki jártas a számítógép 
alkalmazásában (számítógépes mérésvezérlés, szövegszerkesztés, képfeldolgozás, internet, HTML). Mindez azonban 
nem jelenti azt, hogy akinek elõzetesen nem voltak ilyen ismeretei, az ne kaphatna jelest - ha elég szorgalmasan 
dolgozik.  

 

1. BEVEZETÉS 

írta: Márk Géza István, mark@sunserv.kfki.hu 

A pásztázó alagútmikroszkóp (Scanning Tunneling Microscope, STM) elektromosan vezetõ felületek atomi léptékû 
vizsgálatára és módosítására alkalmas eszköz. Az alagútmikroszkópban egy igen hegyes tût mozgatunk a felülettõl 
nanométeres távolságra, miközben a tû és a minta közé Volt nagyságrendû feszültséget kapcsolunk. Az STM 
legyakrabban alkalmazott üzemmódjában (állandó áramú leképezés) miközben a minta síkjában a tûvel pásztázó 
mozgást végzünk, egy visszacsatoló hurokkal a tû felület fölötti magasságát úgy szabályozzuk, hogy a tû és a minta 
közötti, általában nanoamper nagyságrendû alagútáram állandó értéken maradjon. A tû így kialakuló háromdimenziós 
mozgása adja az STM képet. A megfelelõ módon zajvédett (elektromos és mechanikai zajok szempontjából egyaránt) 
STM elegendõen sima felületeken - pl. hasított egykristály - rutinszerûen képes elérni az atomi felbontást, lásd az 1.1. 
ábrán.  
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1.1. ábra. Atomi felbontású STM kép HOPG (Highly Oriented Pyrolytic Graphite) felületérõl. 
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Az alagúteffektus  

Ha két vezetõ anyag közé elektromos feszültséget kapcsolunk és ezeket összeérintjük, áram folyik. Az elektródákat 
eltávolítva egymástól az áram megszûnik. Az áram megszûnése azonban nem ugrásszerûen, hanem fokozatosan 
történik, az elektródákat távolítva az áram exponenciálisan csökken. Makroszkópikus elektróda távolságoknál az 
áram mérhetetlenül kicsivé válik, tehát minden gyakorlati szempontból nullának tekinthetõ. Viszont ha az elektródák 
távolsága elegendõen kicsi, azaz a nanométer (nm) tartományba esik, akkor jól mérhetõ áram fog folyni. Ezt a 
jelenséget kvantummechanikai alagúteffektusnak [1] nevezzük.  

 

 
Az alagúteffektus elmélete szerint egy részecske egy d szélességû és V0 magasságú potenciálgáton (1.2. ábra) akkor 

is véges valószínûséggel képes áthatolni, ha az E energiája kisebb a potenciálgát magasságánál, E < V0. Az áthaladás 

valószínûsége: 

 
 

ahol  (Ez a képlet csak aszimptotikusan,  határesetben igaz.)  

Fém elektródák esetén a potenciálgát V0 magassága elektronvolt (eV) nagyságrendû. Ilyenkor az (1) képlet szerint az 

átmeneti valószínûség kb. tizedére csökken, ha az elektródák távolságát 0.1 nm-rel növeljük. Az STM-ben szokásos 
nm nagyságrendû d értékek esetén P jellegzetes értéke kb. 10-5.  

 

Az alagútáram  

Ha a két elektróda közé U
t
 elõfeszítést kapcsolunk, akkor az I

t
 alagútáram nagysága ettõl a feszültségértéktõl, az 

elektródák anyagától és az elektródák közti távolságtól fog függeni. Az alagútáram az alábbi módon becsülhetõ meg.  

A fémes vezetés legegyszerûbb modellje, a szabadelektron gáz modell szerint a vezetési elektronok a fém belsejében 
szabadon mozoghatnak, de a határfelületnek belülrõl nekiütközve visszaverõdnek a fém belsejébe. Mivel a fémek 
tipikus elektronsûrûsége n = 1029 m-3 körüli és az elektronok átlagos sebessége v

F
 = 106 m/s, idõegységenként kb. n 

v
F

 / 6 = 1.7*1034 db elektron ütközik a határfelület egységnyi felületén. Ha az (1) képletet figyelembevéve 

feltesszük, hogy ezeknek P-ed része jut át a másik elektródába, nulladik közelítésként az alagútáramra n v
F

 A P e / 6 

= 2.6 nA adódik, ahol e az elektron töltése, továbbá föltételeztük, hogy az áram egy A = 0.1 nm2 területû alagút 
csatornán át folyik. (Ez utóbbi érték megfelel egy egyatomos STM tû csúcs felületének.) Bár a kapott alagútáram 
nagyságrendileg valóban az STM esetén szokásos nA tartományba esik, ez a durva becslés több szempontból is 
pontosításra szorul. Elsõsorban figyelembe kell venni a Pauli elvet, ugyanis egy adott E energiájú elektron csak akkor 
juthat át a másik elektródába, ha azon az energián rendelkezésre áll ott nem betöltött energiaállapot. Másodsorban az 
is lényeges módon befolyásolja az alagútáramot, hogy milyen az elektronok energia szerinti eloszlása az 

1.2. ábra. V0
 magasságú és d szélességü potenciálgát. Az E energiával érkezõ részecske P 

valószínûséggel hatol át a potenciálgáton és (1-P) valószínûséggel verõdik vissza.

  
(1)
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elektródákban. Ezen hatások figyelembevétele a következõ módon lehetséges.  

 

 
A fémek legegyszerûbb kvantumfizikai modellje, a potenciálkád modell (1.3. ábra) feltételezi, hogy a vezetési 
elektronok egy potenciál dobozba vannak zárva. Ebben a modellben a fém vezetési elektronjainak (azaz a fémben 
szabad mozgásra képes, ún. delokalizált, tehát nem valamely atomhoz kötött elektronoknak) két leglényegesebb 
tulajdonságát vesszük figyelembe: a) az elektronok a fémben kötöttek, kiszabadításukhoz munkát kell befektetni, 
ennek a legkisebb nagysága a  kilépési munka; b) az elektronok egy véges energiasávot foglalnak el, melynek 
szélessége az E

F
 Fermi energia és a legmagasabb energiájú betöltött állapot energiája a Fermi szint.  

Ennek az energiasávnak a szerkezetét a  állapotsûrûség függvény (Density of States, DOS) írja le, definíció 

szerint  az E energia körüli dE infinitezimális energiaintervallumban található elektronállapotok száma. Az 

állapotsûrûség függvény ismeretében az adott szilárdtest legtöbb fontos adata (pl. elektromos, optikai, mechanikai, 
termodinamikai jellemzõk) kiszámítható és mint alább megmutatjuk, az alagútáram nagyságát is a DOS határozza 
meg.  

 

1.3. ábra. Potenciálkád modell. A [ -L/2, L/2 ] intervallumban elhelyezkedõ fémben az elektron -(
+E

F
) potenciált, az intervallumon kívüli vákuumban nulla potenciált érzékel. A [ -( +E

F
), -  ] 

közötti energiaszintek betöltöttek, az e fölötti szintek üresek. A bal oldali ábra egy hipotetikus 
állapotsûrûség függvényt mutat. A piros szaggatott vonal jelöli a Fermi szint helyét. 

1.4. ábra. Az alagútáram kialakulásának sávszerkezeti modellje. (a) Az A és a B elektróda távol van 
egymástól. (b) Az elektródákat nm közelségbe hozzuk, a Fermi szintek kiegyenlítõdnek és kialakul a 
kontaktpotenciál. (c) Az elektródák közé U

t
 elõfeszítést kapcsolunk. Az I

t
 alagútáram az e*U

t
 szélességû 

energiaintervallumban folyik, az A elektróda betõltõtt állapotaiból a B elektróda üres állapotaiba. A 
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A 1.4/a. ábrán a két, egymástól kezdetben makroszkópikus távolságban lévõ elektróda potenciálkád sávszerkezetét 
ábrázoltuk. Általános esetben a két elektróda (A és B) különbözõ anyagú, ezért Fermi energiájuk és kilépési 
munkájuk is eltérõ, az ábrán az A elektróda Fermi szintje magasabban helyezkedik el a B Fermi szintjénél. Ha az 
elektródákat olyan közelségbe hozzuk egymáshoz, hogy az elektronok számottevõ valószínûséggel közlekedhessenek 
egyikbõl a másikba (alagúteffektus által), akkor az A elektródából elektronok kezdenek átfolyni a B elektródába. Ez 
azt jelenti, hogy A pozitív, B pedig negatív töltést nyer, minek hatására mindkét elektróda a vákuumszinthez képest 
elektrosztatikus potenciális energiára tesz szert. Mivel ahhoz, hogy a végtelenbõl a "+" töltésû A felületéig vigyünk 
egy elektront "-" munkát, ahhoz viszont, hogy a "-" töltésû B felületéig vigyünk egy elektront "+" munkát kell 
végezni, A energiaszintjei "-", B energiaszintjei pedig "+" irányban tolódnak el a vákuumszinthez képest. 
Következésképpen a két elektróda közt létrejön az ún. kontaktpotenciál. A töltésátfolyás mindaddig tart, amíg a két 
elektróda Fermi szintje ki nem egyenlítõdik (1.4/b. ábra). Mint arról egyszerû számolással meggyõzõdhetünk, a 
kiegyenlítõdés eléréséhez (fémek esetében) a vezetési elektronok összes számához képest elegendõ igen kevés 
elektronnak átjutnia A-ból B-be, tehát a sávszélességek változása teljesen elhanyagolható.  

Ha ezután a két, d távolságban lévõ elektróda közé U
t
 elõfeszítést kapcsolunk, a 1.4/c. ábrán vázolt helyzet áll elõ. 

Ilyenkor csak az ábrán jelölt, U
t
 szélességû energiasávba esõ elektronok juthatnak át az A elektródából a B 

elektródába, mert csak ezeken az energiákon vannak az A elektródában betöltött, a B elektródában pedig üres 
állapotok. Mivel adott E energia körüli dE intervallumban átjutó elektronok száma a P átmeneti valószínûségtõl, 
valamint attól függ, hogy a két elektródában hány állapot van ebben a dE intervallumban, a teljes e U

t
 

energiaintervallumban folyó I
t
 alagútáram:  

 
Ha feltesszük, hogy a P és a tû DOS értékek csak elhanyagolható módon függenek az energiától, a következõ 
összefüggést kapjuk:  

 
 

Az alagútmikroszkóp  

nagyobb energiájú komponensek áram járuléka nagyobb, a nagyobb átmeneti valószínûségük miatt. 

 
(2)

 
(3)
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Az STM, mint eszköz (1.5. ábra) az alábbi módon mûködik.  

z Az egyik elektródát igen hegyes tûnek képezzük ki. Ekkor az alagútáram csak a tû hegye körüli keskeny 
csatornában fog folyni, mivel az alagutazási valószínûség exponenciális távolságfüggése miatt a tû távolabbi 
részei és a minta közötti áram elhanyagolhatóan kicsi. Ennek az alagút csatornának a szélessége körülbelül 
akkora, mint a tû csúcsának a görbületi sugara. Tehát mûszerünk felbontását elsõsorban az alkalmazott tû 
hegyessége határozza meg. Ha atomi skálán hegyes tût alkalmazunk, akkor a felbontás is atomi léptékû lesz. 

z A tût egy olyan háromdimenziós mechanikai mozgató rendszerre szereljük, amely igen finom (század 
nanométeres, vagy finomabb) pontossággal képes mozgatni a tût a minta felett. A gyakorlatban erre a célra 
általában piezoelektromos mozgatókat alkalmaznak. 

z A tû és a minta közé Volt nagyságrendû elõfeszítést kapcsolunk. 

z Ezután a tût óvatosan addig közelítjük a felülethez, amíg megjelenik az alagútáram és elér egy elõre beállított 
I
Referencia

értéket. Minél nagyobb az I
Referencia

, annál közelebb kerül a tû a felülethez, gyakorlatban a tipikus 

nagysága nA körüli. 

z A minta X-Y síkjában a tûvel pásztázó mozgást végzünk, hasonlóan a TV készülékekben alkalmazott 
vezérléshez (1.5. ábra). Természetesen, mivel itt nem elektronsugarat, hanem makroszkopikus tömegeket 
mozgatunk, a mechanikai rendszer tehetetlensége és rezonanciái miatt az alkalmazható kép- illetve 
sorfrekvencia kisebb, mint a TV esetén megszokott. Ezért egy STM kép fölvétele általában másodpercekig, 
vagy percekig tart. 

z Pásztázás közben a tû minta feletti magasságát (Z pozícióját) egy visszacsatoló hurokkal úgy szabályozzuk, 
hogy a mért alagútáram állandóan megegyezzen az I

Referencia
 értékkel. 

z Ily módon a tû minden egyes (X,Y) pozíciójához egy meghatározott Z érték fog tartozni. Ezeket a Z(X,Y) 
értékeket számítógéppel rögzítjük. (A módszer hõskorában [13]. a Z(X,Y) felületet úgy jelenítették meg, hogy 
az egyes Z(X,Y=const) pásztázási sorokat analóg rajzgéppel vastag papírra rögzítették, majd a papírból 
kivágták és egymás mögé ragasztották.) 

z Az STM-ben igen gondos rezgéscsillapításra van szükség, mivel a tût a minta fölött nanométeres távolságban 
kell mozgatnunk. Ha a tû beleütközik a mintába, az általában a tû hegyének és a mintának a sérülését okozza, 

1.5. ábra. A pásztázó alagútmikroszkóp elvi mûködése. Az alsó kis ábra azt mutatja be, milyen három 
dimenziós mozgást végez a tû a pásztázás alatt. 
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továbbá, az alagútköz szélességének véletlenszerû változásai "zajként" jelennek meg a felvett képen. A 
nagyamplitúdójú zaj elfedi a jellemzõen 0.01 - 0.1 nm -es atomi korrugációt. 

z Bár az elsõ STM kísérleteket ultra nagy vákuumban (UHV) végezték, késõbb megállapították, hogy az 
alagútmikroszkóp normál levegõn, sõt még (szigetelõ) folyadékban is kiválóan mûködik! Ezért a költséges és 
nehézkes vákuumrendszereket csak akkor szükséges alkalmazni, ha a mérendõ felület tulajdonságai ezt 
megkívánják, azaz ha a vizsgált minta a levegõn oxidálódna, illetve szennyezõdne. Mivel a nem oxidálódó 
minták (pl. a szén) levegõn vizsgálhatóak, az alagútmikroszkóp egy viszonylag olcsó eszköz, összehasonlítva a 
modern fizika egyéb mérõeszközeivel, például az elektronmikroszkóppal. 

 

STM üzemmódok 

A gyakorlatban az alagútmikroszkópot általában vagy ún. topográfiai, vagy ún. spektroszkópiai üzemmódban 
használjuk.  

Topográfiai üzemmódban rögzített U
t
 elõfeszítés és I

Referencia
 alagútáram érték mellett a Z(X,Y) felületet vesszük 

fel. Ha feltételezzük, hogy a P átmeneti valószínûség és a minta állapotsûrûsége mindegyik (X,Y) pontban egyforma, 
a Z(X,Y) felület nulladik közelítésben a minta geometriai felületét, topográfiáját fogja megadni. Azonban a 
gyakorlatban ezek a mennyiségek a helytõl is függhetnek, tehát a mért Z(X,Y) felület együttesen tartalmazza a 
topográfiai és az elektronszerkezeti információt. A topográfiai üzemmódban leggyakrabban kicsi elõfeszítést 
alkalmazunk. Ha U

t
 infinitezimálisan kicsi, a (2) képlet integrandusában a DOS és P energiafüggése elhanyagolható. 

Mivel a DOS helyfüggése mellett az átmeneti valószínûség helyfüggése kisebb szerepet játszik, az alagútáram 
mindenhol a minta állapotsûrûség Fermi szintnek megfelelõ értékével lesz arányos:  

 
Mivel a visszacsatoló hurok folyamatosan az I

Referencia
állandó értéken tartja az I

t
 alagútáramot, a topográfiai kép elsõ 

közelítésben egy állandó állapotsûrûségû felület lesz.  

Spektroszkópiai üzemmódban (Scanning Tunneling Spectroscopy, STS) egy, kiválasztott (X,Y) pontban megállunk 
a tûvel és ideiglenesen kikapcsoljuk a visszacsatoló hurkot is. Ebben a rögzített r

0
 tû helyzetben felvesszük az 

alagútátmenet áram-feszültség karakterisztikáját, azaz az U
t
 elõfeszítést változtatva megmérjük az I

t
 alagútáram 

változását. Mivel U
t
 változtatása a (3) képlet integrálási határa változtatásának felel meg, a mért áram feszültség 

szerinti deriválásával a képlet integrandusának energiafüggését kapjuk:  

 
 

Az STM családja  

A zseniális ötletek általában megtermékenyítõleg hatnak a tudomány fejlõdésére. Az STM esetén is így történt, ez 
vezetett az ún. pásztázó szondás módszerek családjának létrejöttéhez. Mindegyik ilyen eszközben egy hegyes szondát 
pásztáznak a minta fölött és a szonda és a minta valamiféle kölcsönhatását mérik. A legfontosabb ezek közül az 
atomerõ mikroszkóp (Atomic Force Microscope, AFM) [14]. Az AFM-ben, hasonlóan az STM-hez, egy hegyes tût 
mozgatunk a minta fölött és közben a tûre ható erõt a visszacsatoló hurok segítségével állandó értéken tartjuk. Mivel 
ez a mûszer szigetelõ felületek vizsgálatát is lehetõvé teszi, az ipari kutatásokban is gyakran használják.  

 

 

2. MÛSZEREK 

 (4)

 
(4)
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írta: Daróczi Csaba Sándor (daroczi@mfa.kfki.hu) és Koós Antal (koos@mfa.kfki.hu) 

A mérésekhez egy Veeco (DI) gyártmányú Nanoscope E STM/AFM készülékkel rendelkezünk. Ennek jellemzõje a 
moduláris felépítés, ami lehetõvé teszi, hogy különféle pásztázó fejeket, vezérlõ elektronikákat és számítógépeket 
illeszthessünk össze. A berendezés szabad levegõn mûködik. Esetünkben a mérõfej 10x10 mikron vízszintes és 3 
mikron függõleges tartomány pásztázását teszi lehetõvé, de ez egyszerûen kicserélhetõ nagyobb tartomány 
pásztázására képes fejre is. A rendszer blokkvázlatát a következõ ábrán láthatjuk: 

A rezgéscsillapító alapvetõ feladata, hogy a külvilág felõl érkezõ mechanikai vibrációkat távol tartsa a 
tulajdonképpeni STM-tõl, illetõleg elfogadható szintûre csillapítsa azokat. Ez nagyon fontos része a készüléknek, 
hiszen a mintát letapogató tût mindössze nm-es (10-9 m) távolságban kell a minta felületétõl mozgatnunk, ezért ha a 
rezgések ennél nagyobb amplitúdójú relatív elmozdulását okozzák a tûnek és a mintának, akkor a tû beleszaladhat a 
mintába, ami természetesen a tû hegyének letompulását és a minta lokális roncsolódását okozza. Egészen 
kisfrekvenciás zavarok esetén a helyzet azért drámainak nem mondható, ugyanis a mindenkori tû-minta távolságot 
egy néhány kHz frekvenciával reagálni képes negatív visszacsatolás szabályozza. Tehát amíg a rázkódásból eredõ 
relatív elmozdulások nem túl gyorsak és nem lépik túl a szabályozási tartományt, addig az STM megõrzi 
mûködõképességét. Sajnos azonban a mûködõképesség megõrzése még nem jelent optimális mûködést, ugyanis a 
sikeresen kompenzált mechanikai rezgés esetén is hozzáadódik a hasznos jelhez a zavaró jel, ami különféle, nem 
valós periodikus struktúrák megjelenését eredményezi az STM képen. Így tehát elsõrendû feladatunk, hogy a 
hangfrekvenciás rezgések szintjét nagyságrendekkel csillapítsuk, az infrahangokét pedig annyira, amennyire 
módunkban áll. A csillapítás elvi alapja az, hogy mérsékeljük az STM fejre ható, a külsõ vibrációkból eredõ gyorsító 
erõt, rugalmas felfüggesztés közbeiktatásával. 

2.1. ábra. Az STM mérõrendszer blokkvázlata.  
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Az STM mikroszkóp fejben (2.2. ábra) található a készülék "lelke", amely nem más, mint a letapogató tû. Ez 
voltaképpen egy, az egyik végén atomi léptékben hegyes vékony wolfram, vagy platina-ródium drót. Az STM tût a 
mérõfejen található csövecskébe helyezzük. Felvetõdik a kérdés, hogy hogyan lehet ilyen jól kihegyezni egy drótot? 
Nos, erre léteznek különféle módszerek (pl. elektrokémiai maratás). Mi a közönséges mechanikai hegyezéshez 
folyamodunk, a drótot egy éles ollóval, távolító mozdulattal kombináltan elvágjuk. A tûket optikai mikroszkóp alatt 
ellenõrizzük. Természetesen, nincs arra garancia, hogy az optikailag tökéletesnek látszó tû akárcsak elfogadható is 
legyen, hiszen az optikai mikroszkópban csak kb. mikronos felbontásban láthatjuk a tû végét, vagyis mintegy 3-4 
nagyságrenddel durvábban a kelleténél. A gyakorlat azonban azt mutatja, hogy egy ügyes kezû ember minden 
tizedik-huszadik hegyezése bizonyos mérésekhez elfogadható tût eredményez. A tû végének keresztmetszete 
általában nem körszimmetrikus, hanem valamilyen irányban elnyújtott. A mindkét irányban (X, Y) egyformán 
hegyes tû sokkal ritkábban sikerül. A mechanikai hegyezéssel elõállított tûk jellegzetes hibája, hogy a végükön 
egymás mellett több ún. nano-csúcs is lehet, amelyek közül az alagútáram az erõs távolságfüggés miatt lényegében 
csak azon át folyik, amelyik a minta felületéhez a legközelebb van. Kellõen sík mintánál (pl. HOPG) a mérés alatt 
végig ugyanaz maradhat az aktív nano-csúcs, miközben tagoltabb felületûeknél (pl. csiszolt fémeknél) akár többször 
is megváltozhat egyetlen mérés alatt. (Ilyenkor a pásztázás kissé máshol folytatódik, mint "hiszi" azt az adatgyûjtõ 
program.) Az elõbbi tûhibákra a felvett képek minõségébõl következtethetünk. Vagyis egy tû jóságát végsõ fokon 
onnan tudjuk megítélni, hogy milyen képeket tudunk vele készíteni. Ezért a megfelelõ tû elkészítése meglehetõsen 
idõigényes eljárás, hiszen egy-egy próba mérés elõkészítése és elvégzése sok-sok percre rúghat. Akár egy teljes napot 
is igénybe vehet a kísérletezés, amíg végre szert teszünk egy kiváló minõségû tûre. Ráadásul a tû egy szempillantás 
alatt bármikor tönkre is mehet, hiszen elegendõ egy icipicit beleütköznie a minta felületébe. A helyzet orvoslására a 
méréshez 1-1 megfelelõen jól hegyezett tût eleve biztosítunk, de természetesen a diákok is próbálkozhatnak a tû 
hegyezéssel. A tû közvetlenül egy elõerõsítõhöz csatlakozik, így lecsökkenthetõ az alagútáramra tevõdõ zaj. A 
berendezés minimum 200 pA alagútáramon képes dolgozni, ennél kisebb áramokon látványosan lelassul az 
elõerõsítõ. 
A minta mechanikai mozgatását (pásztáztatását) egy piezokerámia szkenner csõ végzi, megfelelõ (maximum +/- 220 
V-os) feszültség hatására. A tû durva közelítését és távolítását 3 mikrométer csavar végzi, ebbõl 2 csavar kézzel 
mozgatható, 1 csavart motor mûködtet. Minta- illetve tûcsere esetén a tû az elõerõsítõvel együtt levehetõ. Tûcsere 
után az elõerõsítõt rugókkal rögzítjük, a tût a csavarokkal kézzel kb. 0,1 mm távolságra közelítjük a mintához, majd a 
számítógép segítségével folytatjuk a tû mozgatását. 
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2.2. ábra. STM mikroszkóp fej 

A mérés vezérlését és az adatok gyûjtését számítógép végzi. Az egyszerûbb kezelhetõség miatt két monitort 
használunk, a vezérlõ monitoron a mérési paraméterek állíthatók, a kijelzõ monitoron pedig az STM kép látható. 

A mérés üzemmód (Realtime) a  gomb segítségével indítható, a rögzített képek (Offline) pedig a  gomb 
megnyomásával érhetõk el. 

Mérés üzemmódban  (2.3. ábra) a Scan Controls ablakban állítható a pásztázási ablak mérete, a pásztázás helye, 
szöge, frekvenciája, sebessége és felbontása. A pásztázási sebesség (frekvencia) megválasztásánál figyelembe kell 
venni a visszacsatoló rendszer tehetetlenségét és a minta durvaságát, mivel a nagy sebesség a minta és/vagy a tû 
sérülését eredményezheti. Az STM kép felbontása 128, 256 vagy 512 pont/vonal lehet. A Feedback Controls
ablakban állítható az alagútáram, a tû-minta feszültség és a visszacsatolás erõssége. Nagyobb Integral és Proportional 
Gain értékek gyorsabb pásztázást tesznek lehetõvé, viszont túl nagy értékek esetén a visszacsatoló hurok begerjed. A 
maximális függõleges pásztázási tartomány és a színskála az Other Controls ablakban állítható. Ismeretlen minta 
esetén érdemes a maximális függõleges tartományt használni, viszont ez gyengébb függõleges felbontást eredményez 
(felbontás=Z limit/2^16). A Channel ablakokban választható a rögzített adatok típusa (magasság vagy áram), skála 
mérete, pásztázás iránya és a dõléskiegyenlítés módja. 
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2.3. ábra. Mérés üzemmód 

A mérésvezérlõ program felépítése hasonlít a Windows programokhoz. Az utasítások menükbe vannak csoportosítva, 

a gyakran használt utasítások közvetlenül elérhetõk.  a tût addig közelíti a mintához, amíg a beállított áram meg 

nem jelenik.  hatására a tû eltávolodik a mintától.  megnyomásával a készülõ képet,  megnyomásával 

pedig az utolsó pásztázási vonalat jelenítjük meg a képernyõn.  lentrõl vagy fentrõl indítja a pásztázást. 

 be vagy ki kapcsolja a kép rögzítését. A képernyõ alján látható a mérõfej típusa, az üzemmód, a tû állapota, 
képrögzítés állapota, a file neve és az idõ. A file neve a Capture->Capture Filename paranccsal állítható be.  

Mérés közben a kijelzõ képernyõn (2.4. ábra) követhetõ a pásztázás. A képernyõ bal oldalán az 1-es csatorna (jobbról 
balra pásztázás) adatai láthatók, a képernyõ jobb oldalán pedig a 2-es csatorna adatai. FONTOS folyamatosan 
figyelni a képernyõ bal alsó sarkában található Z Center Position kijelzõt, amely a piezo kerámiára kapcsolt 
feszültséget jelzi. Ha a piros nyíllal jelzett fehér függõleges vonal a zöld téglalap végéhez ér, akkor a kerémia 
maximálisan összehúzódott vagy kinyúlt és képtelen a felületet követni. A maximális függõleges tartomány (Z limit) 
növelésével vagy a pásztázási ablak (Scan size) csökkentésével általában javítható a helyzet. Ha ez nem sikerül, 

akkor a tût ki kell húzni . 
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2.4. ábra. Kijelzõ képernyõ 

 
 

 

3. MINTÁK 

írta: Daróczi Csaba Sándor, daroczi@mfa.kfki.hu 

Ahhoz, hogy az STM-mel meg tudjunk mérni egy mintát, szükséges, hogy a felülete elektromosan vezetõ legyen. 
Mint tudjuk, a fémek általában kiváló elektromos vezetõk, ezért joggal reménykedhetünk abban, hogy az STM-mel 
jól meg tudjuk mérni õket. Sajnos azonban ez mégsincs mindig így. Pl. az alumínium kiváló elektromos vezetõ, de a 
felületén a szabad levegõn a legrövidebb idõn belül is kialakul egy vékony oxid réteg (Al2O3), amely viszont a 

legkiválóbb szigetelõk közé tartozik (olyannyira, hogy nagyfeszültségû szigetelõ kerámiák legfõbb alapanyaga), és 
mindennek a tetejében még nagyon kemény is (csiszolóanyag és drágakõ, lásd korund, zafír). Hasonlóan tudjuk a 
vasról is, hogy igen hajlamos a rozsdásodásra (oxid és hidroxid vegyesen), és a rozsda egykettõre olyan vastag lehet, 
hogy a letapogató tût teljesen elfedi, beszennyezi. 
Logikus arra gondolni, hogy a nemesfémekkel talán több szerencsénk lesz. És valóban, pl. az arany és a platina 
szabad levegõn is egészen jól mérhetõk STM-mel, de pl. az egyébként legkiválóbb elektromos vezetõ ezüst nem! 
Ennek oka nem az oxigén, hanem az oxigén csoportjába tartozó másik kémiai elem, a kén. Ez ugyanis az ipari 
szennyezés miatt mindig jelen van a levegõben, az ezüst pedig igen könnyen alkot vele szulfidot. (Ez adja az ezüst 
tárgyak sötétszürke színét is.) A félnemes fémnek tekinthetõ vörösréz sem problémamentes, ugyanis elég könnyen 
oxidálódik (barna szín), illetve képzõdik rajta zöldes-kékes színû patina (nitrátok, hidrokarbonátok, stb.). 
Segítségünkre van viszont, hogy a réz oxidja (CuO) félvezetõ természetû (a század elején fel is használták 
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egyenirányítási célokra), ilyenformán az alagútáram kialakulását nem akadályozza meg, feltéve, hogy az oxid réteg 
nem túl vastag. (A frissen vákuumpárologtatott réz réteg napokig is mérhetõ maradhat szabad levegõn STM-mel.) 
Bizonyos fémek jól mérhetõk szabad levegõn, pl. a nikkel, a króm és a molibdén. Ezeken csak vékony a kialakuló 
oxid réteg, és ráadásul eléggé félvezetõ természetû is. (Nem véletlen, hogy tükrözõ felületek készítésére is használják 
õket.) Egyes anyagok egyáltalán nem fémek, pl. az SnO2, de szép és stabil félvezetõ kristályokat alkotnak, így 

remekül mérhetõk. A legfontosabb félvezetõvel, a szilíciummal viszont problémánk van, ugyanis igen gyorsan (a 
másodperc töredéke alatt) oxidálódik, és az oxidja, a kvarc (SiO2) a legkiválóbb szigetelõk és legkeményebb anyagok 

közé tartozik. Ezért a szilícium megfelelõ STM-es vizsgálata csak ultranagy-vákuumban lehetséges, az ott 
alkalmazott ("in situ") tisztítást követõ korlátozott ideig. A különlegesebb anyagok közül a fémüvegek elsõsorban 
akkor mérhetõk jól, ha elég nagy mennyiségben tartalmaznak nemesfém összetevõt is. A mágneses szempontból 
fontos permalloy sem reménytelen eset, miután akár 3/4 résznyi nikkelt is tartalmazhat. Azonban a szabadlevegõs 
STM-es vizsgálatok kétségtelenül legnagyobb sztárja a grafit. Ez az anyag úgy él hétköznapi szemléletünkben, mint 
egy elektromosan vezetõ, enyhén fémes csillogású, gyenge, könnyen szétmorzsolható anyag. Azonban a könnyû 
szétmorzsolhatósága kizárólag a rétegeinek egymáshoz képesti könnyû elcsúszásból fakad, miközben az egyes 
rétegeken belül a szénatomokat nagyon erõs kovalens kötések tartják a helyükön. Ezért a grafit kémiailag nagyon 
kevéssé reaktív elem (nem oxidálódik), elektromosan vezet, és a pásztázott felületének számottevõ mechanikai 
tartása is van. Mindezekért viszonylag könnyen elérhetünk rajta akár atomi felbontást is. Ehhez legcélszerûbb 
HOPG-t (Highly Oriented Pyrolitic Graphite) használnunk, amely ránézésre a csillámhoz hasonló réteges szerkezetû 
anyag, csak sötétebb. Minthogy a grafit szén atomjainak kötéstávolságát más módszerekkel is meg tudjuk mérni, így 
a grafit az STM kalibrációjára is felhasználható.  

A konkrét mérésekhez a következõ fajtájú minták közül fogunk válogatni (a mindenkori érdeklõdés és a lehetõségek 
szerint):  

1.) HOPG grafit (atomi felbontáshoz); 
2.) párologtatott nikkel, vagy króm réteg (a szemcseméret statisztikai vizsgálatához); 
3.) permalloy (a felületi oxid hatásának vizsgálatához); 
4.) nemesfém tartalmú fémüveg (amorf felületi struktúrák vizsgálatához); 
5.) arannyal bepárologtatott optikai rács (a rácsállandó meghatározásához); 
6.) esetleges hozott minta (pl. kicsiny arany, vagy platina ékszer).  

A minták mérete tipikusan nem haladhatja meg a 10 mm-es átmérõt és 2-3 mm-es vastagságot. A legkisebb még 
kényelmesen kezelhetõ méret kb. 3 mm-es átmérõjû és 0.2-1 mm-es vastagságú. A mintákat egy-egy mintatartóra 
kell rögzítenünk. A rögzítésnek egyszerre kell biztosítania az elektromos vezetést és a mechanikai stabilitást. 
Mindkét feltételnek megvannak a maga nehézségei, ugyanis egy kicsit is bizonytalan mechanikai illesztést minden 
"bolygatás" után hosszadalmas (akár órákra rúgó!) relaxációs mozgás követhet. Elektromos kontaktust pedig nem 
könnyû biztosítani pl. egy olyan párologtatott fémfelülethez, amely esetleg csak néhány nm vastag.  

 

 

4. MÉRÉS 

írta: Koós Antal Adolf (koos@mfa.kfki.hu) 

A mérés egymást követõ lépései a minta konkrét fajtájától függetlenül hasonlóak. Az általános eljárás a következõ: 

1.) Ellenõrizzük, hogy az egyes egységek helyesen vannak-e összekapcsolva, majd a fõkapcsolóval egyszerre 
bekapcsoljuk a vezérlõ elektronikát és számítógépet (hogy mielõbb felvegye az üzemi hõmérsékletet). (Ezt a 
gyakorlatvezetõ elvégzi a mérés megkezdése elõtt.) 
2.) Elõkészítjük a mérendõ mintát (hogy mielõbb bekövetkezhessen a mechanikai relaxációja). (Általában a 
gyakorlatvezetõ ezt is elvégzi a mérés megkezdése elõtt.) 
3.) Következõ lépésként megpróbálunk elõállítani egy elfogadhatóan hegyes tût. (Bár lesz a gyakorlatvezetõ által 
elõzetesen meghegyezett tû is, a diákoknak is meg kell kísérelniük a hegyezést.) 
4.) Ezután egy csipesszel behelyezzük a tût a foglalatába, a tû-minta távolságot kb. 0.1 mm-re csökkentjük, majd a 
mérõfejet rezgésmentes asztalra helyezzük. (Elsõ alkalommal ezt megmutatja a gyakorlatvezetõ, késõbb a diákoknak 
célszerû megtenniük.) 
5.) Beállítjuk a kívánt pásztázási paramétereket (ablakméret, soronkénti pixelszám, pásztázási sebesség, 
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alagútfeszültség és áram), majd aktiváljuk a durva közelítõ mechanizmust  
6.) A mérésvezérlõ szoftver automatikusan elindítja az adatgyûjtést. Amennyiben a kép megfelelõ, úgy elmentjük a 

HDD-re . Ha a kép nem megfelelõ, akkor a paraméterek állításával megpróbálunk javítani rajta. Ha ez 

semmiképp sem sikerül, annak leggyakoribb oka, hogy a tû szennyezett, vagy tompa. Ekkor leállítjuk a mérést ,  
8.) a tû-minta távolságot legalább 2 mm-re növeljük 
9.) kivesszük a tût és visszatérünk a 3.)-es ponthoz, vagyis a tû újbóli meghegyezéshez, vagy cseréjéhez. 

 
 

 

5. KÉPFELDOLGOZÁS 

írta: Koós Antal Adolf (koos@mfa.kfki.hu) 

A rögzített képek Offline üzemmódban  a ! meghajtón találhatók (5.1 ábra).  

 

5.1 ábra. Offline üzemmód 

A mérési file általában két képet tartalmaz (Channel1 és Channel2), egyiket jobbról balra, a másikat balról jobbra 
pásztázva készítjük. A kép szûrése elõtt ki kell választani egyik képet az Image->Select Left Image vagy Image-
>Select Right Image parancs segítségével. A kép kiválasztása után elérhetõvé válnak a szûrési, mérési és 
megjelenítési lehetõségek (5.2 ábra)  
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5.2. ábra. Képfeldolgozás 

A képfeldolgozást ajánlott a Modify->Plane fit Auto  (felület illesztése a rögzített képhez) vagy Modify-

>Flatten  (görbe illesztése a pásztázási vonalakhoz) utasításokkal kezdeni. A képen található tüskék Modify-
>Median (mátrix szûrõ) vagy Modify->Lowpass (nagy frekvenciákat levágó) szûrõvel távolíthatók el. A különösen 
zajos pásztázási vonalak eltávolíthatók a Modify->Erase Scan Lines paranccsal. A periodikus struktúrák Modify-
>Spectrum 2D Fourier szûrõvel emelhetõk ki. A szûrõket minden esetben körültekintõen kell használni, mivel azok 

eltorzíthatják a képet. Távolságokat és magasságokat az Analyze->Section (vonalmetszet)  utasítás segítségével 

mérhetünk. A képek két vagy három dimenziós ábrázolásban a View->Top View  vagy a View->Surface Plot 

 utasításokkal jeleníthetõk meg. A képek kontrasztja bármely szûrõ használatakor állítható. A képek mentésére a 
Utility->TIFF Export utasítás használható. A Nanoscope program saját formátuma a megszokott képfeldolgozó 
programok segítségével nem nyitható ki, viszont a Nanotec Electronica cég ingyenes WSxM 3.0 vagy annál újabb 
programja képes kinyitni és feldolgozni a Nanoscope fileokat. A WSxM program mûködése hasonlít a Nanoscope 
program mûködéséhez, viszont a megjelenése és az utasítások megnevezése eltér. A kép dõlését a teljes képhez 
(Process-> Plane-> Global) vagy a kép egy részéhez (Process-> Plane-> Local) illesztett sík kivonásával tudjuk 
eltávolítani. Szükség esetén a Process-> Filter-> Fit2nd utasítással másodfokú felületet vonhatunk ki a képbõl. Az 
egyes pásztázási vonalak magassága gyakran eltér, ezért általában érdemes végrehajtani a Process-> Filter-> Flatten
parancsot. Ezzel az utasítással minden pásztázási vonalhoz egyenest (Offset - nincs dõlés és Line - van dõlés) vagy 
parabolát (Parabola) illesztünk, és azt kivonjuk a pásztázási vonalból. Process->Filter->Flatten->Line a Process-> 
Plane-> Global parancsot is helyettesíti. A képen tálalható tüskék eltávolíthatók például a Process-> Filter-> 
Matrix convolution-> Smooth_3x3 átlagoló mátrixszûrõvel. A kép egy részlete a Process-> Zoom paranccsal 
nagyítható ki. Vonalmetszetet a Process-> Profile paranccsal készíthetünk. A metszeten Process-> Measure
distance utasítással lehet megmérni két pont távolságát. A kép 3D megjelenítése a Display-> 3D Settings and 
Preview utasítással módosítható. Itt lehetõség van a kép döntésére és forgatására, valamint a megvilágítás irányának 
a változtatására is. 2D ábrázolásban (Display-> Top View) fontos színskálát használni. A színskála a Display-> Info
paranccsal érhetõ el. 
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6. JEGYZÕKÖNYV 

írta: Daróczi Csaba Sándor, daroczi@mfa.kfki.hu 

A jegyzõkönyvet MS Word, vagy HTML formátumban kell elkészíteni és eljuttatni a gyakorlatvezetõnek. Utóbbi 
azért elõnyös, mert így a jobban sikerült munkákat az interneten keresztül is hozzáférhetõvé tudjuk tenni (legalább 
egy idõre). 
A mérõpároknak 1 db közös jegyzõkönyvet kell elkészíteniük, de ez még nem feltétlenül eredményez azonos 
érdemjegyet, ugyanis a szóbeli teljesítményük és a mérésnél felmutatott ügyességük erõsen különbözõ lehet. 
Ha egy mérõpárnak nem áll a rendelkezésére számítógép, az feljöhet a KFKI-ba is elkészíteni a jegyzõkönyvet (egy 
megbeszélt idõpontban). A jegyzõkönyv nyomtatott, vagy akár még kézzel írott formában is elfogadható (de az 
gyakorlatilag kizárja ez internetes hozzáférhetõvé tételt).  

A jegyzõkönyvnek tartalmaznia KELL a következõket: 
1.) személyi adatokat; 
2.) az STM mûködési alapelvének leírását (saját szavakkal); 
3.) a megvizsgált mintá(k) leírását; 
4.) a fõbb mérési paraméterek leírását; 
5.) az elvégzett mérések (illetve mérési kísérletek) rövid jellemzését; 
6.) demonstrációs ábrákat, a hozzájuk tartozó szöveggel együtt(!);  

A jegyzõköny értékét különösen emeli, ha kiderül belõle, hogy a mérõpár hogyan tudott úrrá lenni egy-egy mérési, 
vagy képfeldolgozási problémán, illetve milyen hasznosítható következtetésekre jutott. 
És fordítva, a jegyzõkönyv értékét jelentõsen rontja, ha alapvetõ fogyatékosságokkal, vagy tévedésekkel terhes.  

Megjegyzés: 
Tervezzük egy olyan web oldal készítését is, amelyet akár az interneten keresztül is kitölthetnek a diákok, így a 
jegyzõkönyvek egybõl egy egységes HTML formátumban keletkeznének.  
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